Legal Notices

This guide is copyrighted ©2009 by Digidesign, a division of Avid Technology, Inc. (hereafter “Digidesign”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Digidesign.

Guide Part Number 9329-61710-00 REV A June, 2009

Documentation Feedback

We’re always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@digidesign.com.
# contents

## Chapter 1. Introduction
- Plug-in Formats ................................................. 1
- System Requirements and Compatibility ......................... 2
- Installing and Using Plug-ins for Pro Tools M-Powered Essential ......................... 2
- Conventions Used in This Guide ................................ 3
- About www.digidesign.com ..................................... 3

## Chapter 2. Click
- Click Controls .................................................. 5
- Creating a Click Track .......................................... 6

## Chapter 3. AIR Chorus, Flanger, and Phaser.
- AIR Chorus ..................................................... 7
- AIR Flanger ..................................................... 8
- AIR Phaser ..................................................... 10

## Chapter 4. D-Verb
- D-Verb Controls ................................................. 13

## Chapter 5. Dynamics III
- Shared Compressor/Limiter and Expander/Gate Features .................. 17
- Compressor/Limiter III ......................................... 20
- Expander/Gate III ............................................... 24
- De-Esser III ..................................................... 26
- Using the Side-Chain Input in Dynamics III .............................. 29
<table>
<thead>
<tr>
<th>Chapter 6. EQ III</th>
<th>33</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ III Controls</td>
<td>34</td>
</tr>
<tr>
<td>7 Band EQ</td>
<td>39</td>
</tr>
<tr>
<td>2-4 Band EQ</td>
<td>44</td>
</tr>
<tr>
<td>1 Band EQ</td>
<td>45</td>
</tr>
<tr>
<td>Chapter 7. Mod Delay II</td>
<td>49</td>
</tr>
<tr>
<td>Mod Delay II Controls</td>
<td>49</td>
</tr>
<tr>
<td>Multichannel Mod Delay II</td>
<td>51</td>
</tr>
<tr>
<td>Selections for ModDelay II AudioSuite Processing</td>
<td>51</td>
</tr>
<tr>
<td>Chapter 8. ReWire</td>
<td>53</td>
</tr>
<tr>
<td>ReWire Requirements</td>
<td>55</td>
</tr>
<tr>
<td>Using ReWire</td>
<td>55</td>
</tr>
<tr>
<td>Quitting ReWire Client Applications</td>
<td>58</td>
</tr>
<tr>
<td>Tempo and Meter Changes</td>
<td>58</td>
</tr>
<tr>
<td>Looping Playback</td>
<td>59</td>
</tr>
<tr>
<td>Automating ReWire Input Switching</td>
<td>59</td>
</tr>
<tr>
<td>Chapter 9. SansAmp PSA-1</td>
<td>61</td>
</tr>
<tr>
<td>PSA-1 Controls</td>
<td>62</td>
</tr>
<tr>
<td>Tips and Tricks</td>
<td>62</td>
</tr>
<tr>
<td>Chapter 10. Structure Essential</td>
<td>63</td>
</tr>
<tr>
<td>Introduction</td>
<td>63</td>
</tr>
<tr>
<td>Getting Started</td>
<td>63</td>
</tr>
<tr>
<td>Structure Essential Parameters</td>
<td>66</td>
</tr>
<tr>
<td>Patch List</td>
<td>67</td>
</tr>
<tr>
<td>Main Page</td>
<td>70</td>
</tr>
<tr>
<td>Patch Edit Sub-Pages</td>
<td>70</td>
</tr>
<tr>
<td>Browser Page</td>
<td>72</td>
</tr>
<tr>
<td>Chapter 11. Other AudioSuite Plug-ins</td>
<td>75</td>
</tr>
<tr>
<td>Reverse</td>
<td>75</td>
</tr>
<tr>
<td>Index</td>
<td>77</td>
</tr>
</tbody>
</table>
Introduction

Plug-ins are special-purpose software components that provide signal processing and other functionality to Pro Tools® M-Powered™ Essential.

The plug-ins included with Essential provide a comprehensive suite of effects processing (such as EQ, reverb, and delay) as well as the Structure Essential virtual instrument.

⚠️ References to Pro Tools LE® or Pro Tools M-Powered™ in this guide are usually interchangeable with Pro Tools M-Powered Essential, except as noted in the Pro Tools M-Powered Essential User Guide.

The Essential plug-ins installed with Pro Tools M-Powered Essential include:

- Click
- AIR Chorus
- AIR Flanger
- AIR Phaser
- D-Verb
- Dynamics III
  - Compressor/Limiter
  - Expander/Gate
  - De-Esser
- EQ III
  - 7 Band
  - 2–4 Band
  - 1 Band
- ModDelay II
  - Extra Long
  - Long
  - Medium
  - Short
  - Slap
- ReWire
- Sans Amp PSA-1
- Structure Essential
- Other DigiRack AudioSuite Plug-ins
  - Multi-Tap Delay
  - Ping-Pong Delay
  - Reverse

Plug-in Formats

There are two plug-in formats used in Pro Tools M-Powered Essential:

- RTAS® plug-ins (real-time, host-based)
- AudioSuite™ plug-ins (non-real-time, file-based processing)
RTAS Plug-ins

RTAS (Real-Time AudioSuite) plug-ins are applied as track inserts, are applied to audio during playback, and process audio non-destructively in real-time. RTAS plug-ins rely on and are limited by the processing power of your computer. The more powerful your computer, the greater the number and variety of RTAS plug-ins that you can use simultaneously.

Because of this dependence on the CPU or host processing, the more RTAS plug-ins you use concurrently in a session, the greater the impact it will have on other aspects of your system’s performance, such as maximum track count, number of available voices, the density of edits possible, and latency in automation and recording.

AudioSuite Plug-ins

AudioSuite plug-ins are used to process and modify audio files on disk, rather than non-destructively in real time. Depending on how you configure a non-real-time AudioSuite plug-in, it either creates an entirely new audio file, or alters the original source audio file.

System Requirements and Compatibility

Essential Plug-ins can only be used on Pro Tools M-Powered Essential systems.

For complete system requirements and a list of computers, operating systems, hard drives, and third-party devices, refer to the latest information on the Digidesign website:
www.digidesign.com/compatibility

Installing and Using Plug-ins for Pro Tools M-Powered Essential

Installing Plug-ins

The Essential plug-ins are installed when you install Pro Tools M-Powered Essential. For more information, see the Essential User Guide.

Using Plug-ins in Pro Tools

Plug-ins are used in sessions by inserting them onto tracks. Essential lets you insert as many as three plug-ins per track using insert slots A–C.

To insert a plug-in:

1. Click the track Insert selector. Plug-ins are listed by category (or, the type of processing they perform) such as Delay, Dynamics, and EQ.

2. Choose a plug-in from one of the sub-menus.

See the Intro to Pro Tools M-Powered Essential Guide for more information about how to use plug-ins as track inserts or as bus processors.

See the Pro Tools Reference Guide for complete information on working with plug-ins, including:

- Plug-in Window controls
- Adjusting plug-in controls
- Automating plug-ins
- Using side-chain inputs
- Using plug-in presets
- Clip indicators
Conventions Used in This Guide

All Digidesign guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your system.

⚠️ Important Notices include information that could affect your Pro Tools session data or the performance of your Pro Tools system.

ISP Shortcuts show you useful keyboard or mouse shortcuts.

🗂️ Cross References point to related sections in this guide and other Essential guides.

About www.digidesign.com

The Digidesign website (www.digidesign.com) is your best online source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

Product Registration Register your purchase online.

Support and Downloads Contact Digidesign Technical Support or Customer Service; download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Answerbase; or join the worldwide Pro Tools community on the Digidesign User Conference.

Training and Education Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

Products and Developers Learn about Digidesign products; download demo software or learn about our Development Partners and their plugins, applications, and hardware.

News and Events Get the latest news from Digidesign or sign up for a Pro Tools demo.

Pro Tools Accelerated Videos Watch the series of free tutorial videos. Accelerated Videos are designed to help you get up and running with Pro Tools and its plug-ins quickly.
The Click plug-in creates an audio click during session playback that you can use as a tempo reference when performing and recording. The Click plug-in receives its tempo and meter data from the Pro Tools application, enabling it to follow any changes in tempo and meter in a session. The Click plug-in is a mono-only plug-in. Several click sound presets are included.

**Click Controls**

**MIDI In LED** Illuminates each time the Click plug-in receives a click message from the Pro Tools application, indicating the click tempo.

**Accented** Controls the output level of the accent beat (beat 1 of each bar) of the audio click.

**Unaccented** Controls the output level of the unaccented beats of the audio click.
Creating a Click Track

To create a click track with the Click plug-in:

1. Ensure that the Options > Click menu command is enabled.
2. Choose Track > Create Click Track.

Pro Tools creates a new Auxiliary Input track named “Click” with the Click plug-in already inserted.

To manually create a click track with the Click plug-in:

1. Select Options > Click to enable the Click option (or enable the Metronome button in the Transport).
2. Create a new mono Auxiliary Input track and insert the Click plug-in.
3. Select a click sound preset.
4. Choose Setup > Click/Countoff and set the Click and Countoff options as desired.

⚠️ The Note, Velocity, Duration, and Output options in this dialog are for use with MIDI instrument-based clicks and do not affect the Click plug-in.

5. Begin playback. A click is generated according to the tempo and meter of the current session and the settings in the Click/Countoff Options dialog.

Refer to the Pro Tools Reference Guide for more information on configuring Click options.
This chapter describes three modulation plug-ins included with Pro Tools M-Powered Essential:

- AIR Chorus
- AIR Flanger
- AIR Phaser

AIR Chorus

Use the Chorus plug-in to apply a short modulated delay to give depth and space to the audio signal.

Chorus Section

Feedback Sets the Feedback amount.

Pre-Delay Delays the chorused signal, in milliseconds.

LFO Section

The LFO section’s controls let you select the waveform, phase, rate, and depth of modulation.

Waveform Selects either a Sine wave or a Triangle wave for the LFO.

L/R Phase Sets the relative phase of the LFO’s modulation in the left and right channels.

Mix

This control adjusts the Mix between the “wet” (processed) and “dry” (unprocessed) signal. 0% is all dry, and 100% is all wet, while 50% is an equal mix of both.

Rate

This controls sets the rate for the oscillation of the LFO in Hertz.

Depth

This control sets the depth of LFO modulation of the audio signal.

See the Pro Tools Reference Guide for information on using plug-in effect controls.
**AIR Flanger**

Use the Flanger plug-in to apply a short modulating delay to the audio signal.

![Flanger plug-in window](image)

**Sync**

When Sync is enabled, the Flanger Rate control synchronizes to the Pro Tools session tempo. When Sync is disabled, you can set the delay time in milliseconds independently of the Pro Tools session tempo. The Sync button is lit when it is enabled.

**Rate**

When Sync is enabled, the Rate control lets you select a rhythmic subdivision or multiple of the beat for the Flanger Modulation Rate. Select from the following rhythmic values:

- 16 (sixteenth note)
- 8T (eighth-note triplet)
- 16D (dotted sixteenth-note)
- 8 (eighth note)
- 4T (quarter-note triplet)
- 8D (dotted eighth-note)
- 4 (quarter note)
- 2T (half-note triplet)
- 4D (dotted quarter-note)
- 2 (half note)
- 1T (whole-note triplet)
- 3/4 (dotted half note)
- 4/4 (whole note)
- 5/4 (five tied quarter notes)
- 6/4 (dotted whole note)
- 8/4 (double whole note)

When Sync is disabled, the Rate control lets you the modulation rate in independently of the Pro Tools session tempo.

**Depth**

The Depth control lets you adjust the amount of modulation applied to the Delay time.

**Pre-Delay**

The Pre-Delay control sets the minimum delay time in milliseconds.
**LFO Section**

The LFO section provides controls for the Low Frequency Oscillator (LFO) used to modulate the Delay time.

**Wave**

The Wave control lets you interpolate between a triangle wave and a sine wave for the modulating LFO.

**L/R Offset**

The L/R Offset control lets you adjust the phase offset for the LFO waveform applied to the left and right channels.

**Retrigger**

Click the Retrigger button to reset the LFO phase. This lets you manually start the filter sweep from that specific point in time (or using automation, at a specific point in your arrangement). Clicking the Trig button also forces the Mix control up if it is too low while the button is held; this ensures that the sweep is audible.

**EQ Section**

The EQ section provides controls for cutting lows from the Flanger signal, and inverting phase.

**Low Cut**

The Low Cut control lets you adjust the Low Cut frequency for the Flanger, to limit the Flanger effects to higher frequencies.

**Phase Invert**

When Phase Invert is enabled, the wet signal’s polarity is flipped, which changes the harmonic structure of the effect.

---

**Feedback**

The Feedback control lets you adjust the amount of delay feedback for the Flanger. At 0%, the delay repeats only once. At +/-100%, the Flanger feeds back on itself.

**Mix**

The Mix control lets you balance the amount of dry signal with the amount of wet (flanged) signal. At 50%, there are equal amounts of dry and wet signal. At 0%, the output is all dry and at 100% it is all wet.

The Mix control can be used to create an “infinite phaser” effect between the dry and shifted signals, which is always rising or always falling (depending on the direction of shift).
AIR Phaser

Use the Phaser plug-in to apply a phaser to the audio signal for that wonderful “wooshy,” “squishy” sound.

![Phaser plug-in window](image)

**Figure 3. Phaser plug-in window**

**Sync**

When Sync is enabled, the Phaser Rate control synchronizes to the Pro Tools session tempo. When Sync is disabled, you can set the Rate in milliseconds independently of the Pro Tools session tempo. The Sync button is lit when it is enabled.

**Rate**

When Sync is enabled, the Rate control lets you select a rhythmic subdivision or multiple of the beat for the Phaser Modulation Rate. Select from the following rhythmic values:

- 16 (sixteenth note)
- 8T (eighth-note triplet)
- 16D (dotted sixteenth-note)
- 8 (eighth note)
- 4T (quarter-note triplet)
- 8D (dotted eighth-note)
- 4 (quarter note)
- 2T (half-note triplet)
- 4D (dotted quarter-note)
- 2 (half note)
- 1T (whole-note triplet)
- 3/4 (dotted half note)
- 4/4 (whole note)
- 5/4 (five tied quarter notes)
- 6/4 (dotted whole note)
- 8/4 (double whole note)

When Sync is disabled, the Rate control lets you the rate of the Phaser in independently of the Pro Tools session tempo.

**Depth**

The Depth control lets you adjust the depth of modulation, which in turn affects the amount of phasing applied to the audio signal.
**Phaser Section**

The Phaser section provides control over the effect’s center frequency and number of phaser stages (or Poles).

**Center**

The Center control lets you change the frequency center (100 Hz to 10.0 kHz) for the phaser poles.

**Poles**

Select the number of phaser poles (stages): 2, 4, 6, or 8. The number of poles changes the character of the sound. The greater the number of poles, the thicker and squishier the sound.

**LFO Section**

The LFO section provides control over the waveform and stereo offset of the LFO.

**Wave**

The Wave control lets you interpolate between a triangle wave and a sine wave for modulating the Phaser.

**L/R Phase**

The L/R Phase control lets you adjust the relative phase of the LFO modulation applied to the left and right channels.

**Low Cut**

The Low Cut control lets you adjust the frequency of the Low Cut Filter in the phaser’s feedback loop. This can be useful for taming low frequency “thumping” at high feedback settings.

**Feedback**

The Feedback control feeds the output signal of Phaser back into the input, creating a resonant or singing tone in the phaser when set to its maximum.

**Mix**

The Mix control lets you adjust the Mix between the “wet” (effected) and “dry” (unprocessed) signal. 0% is all dry, and 100% is all wet, while 50% is an equal mix of both.
D-Verb

(RTAS and AudioSuite)

D-Verb is a studio-quality reverb provided in RTAS and AudioSuite formats.

D-Verb Controls

Output Meter

The Output meter indicates the output level of the processed signal. With the stereo version of D-verb, it represents the summed stereo output. It is important to note that this meter indicates the output level of the signal—not the input level. If this meter clips, it is possible that the signal clipped on input before it reached D-Verb. Monitor your send or insert signal levels closely to help prevent this from happening.

Clip Indicator

The Clip indicator shows if clipping has occurred. It is a clip-hold indicator. If clipping occurs at any time during audio playback, the clip lights remain on. To clear the clip indicator, click it. With longer reverb times there is a greater likelihood of clipping occurring as the feedback element of the reverb builds up and approaches a high output level.

Input Level

The Input Level slider adjusts the input volume of the reverb to prevent the possibility of clipping and/or increase the level of the processed signal.

Mix

The Mix slider adjusts the balance between the dry signal and the effected signal, giving you control over the depth of the effect. This control is adjustable from 100% to 0%.
Algorithm

This control selects one of seven reverb algorithms: Hall, Church, Plate, Room 1, Room 2, Ambience, or Nonlinear. Selecting an algorithm changes the preset provided for it. Switching the Size setting changes characteristics of the algorithm that are not altered by adjusting the decay time and other user-adjustable controls. Each of the seven algorithms has a distinctly different character:

**Hall** A good general purpose concert hall with a natural character. It is useful over a large range of size and decay times and with a wide range of program material. Setting Decay to its maximum value will produce infinite reverberation.

**Church** A dense, diffuse space simulating a church or cathedral with a long decay time, high diffusion, and some pre-delay.

**Plate** Simulates the acoustic character of a metal plate-based reverb. This type of reverb typically has high initial diffusion and a relatively bright sound, making it particularly good for certain percussive signals and vocal processing. Plate reverb has the general effect of thickening the initial sound itself.

**Room 1** A medium-sized, natural, rich-sounding room that can be effectively varied in size between very small and large, with good results.

**Room 2** A smaller, brighter reverberant characteristic than Room 1, with a useful adjustment range that extends to “very small.”

**Ambient** A transparent response that is useful for adding a sense of space without adding a lot of depth or density. Extreme settings can create interesting results.

**Nonlinear** Produces a reverberation with a natural buildup and an abrupt cutoff similar to a gate. This unnatural decay characteristic is particularly useful on percussion, since it can add an aggressive characteristic to sounds with strong attacks.

Size

The Size control, in conjunction with the Algorithm control, adjusts the overall size of the reverberant space. There are three sizes: Small, Medium, and Large. The character of the reverberation changes with each of these settings (as does the relative value of the Decay setting). The Size buttons can be used to vary the range of a reverb from large to small. Generally, you should select an algorithm first, and then choose the size that approximates the size of the acoustic space that you are trying to create.

Diffusion

Diffusion sets the degree to which initial echo density increases over time. High settings result in high initial build-up of echo density. Low settings cause low initial buildup. This control interacts with the Size and Decay controls to affect the overall reverb density. High settings of diffusion can be used to enhance percussion. Use low or moderate settings for clearer and more natural-sounding vocals and mixes.

Decay

Decay controls the rate at which the reverb decays after the original direct signal stops. The value of the Decay setting is affected by the Size and Algorithm controls. This control can be set to infinity on most algorithms for infinite reverb times.
Pre-Delay

Pre-Delay determines the amount of time that elapses between the original audio event and the onset of reverberation. Under natural conditions, the amount of pre-delay depends on the size and construction of the acoustic space, and the relative position of the sound source and the listener. Pre-Delay attempts to duplicate this phenomenon and is used to create a sense of distance and volume within an acoustic space. Long Pre-Delay settings place the reverberant field behind rather than on top of the original audio signal.

Hi Frequency Cut

Hi Frequency Cut controls the decay characteristic of the high frequency components of the reverb. It acts in conjunction with the Low-Pass Filter control to create the overall high frequency contour of the reverb. When set relatively low, high frequencies decay more quickly than low frequencies, simulating the effect of air absorption in a hall. The maximum value of this control is Off (which effectively means bypass).

Low-Pass Filter

Low-Pass Filter controls the overall high frequency content of the reverb by setting the frequency above which a 6 dB per octave filter attenuates the processed signal. The maximum value of this control is Off (which effectively means bypass).
Dynamics III

(RTAS and AudioSuite)

Dynamics III provides three modules:
- Compressor/Limiter
- Expander/Gate
- De-Esser

All Dynamics III modules are available in RTAS and AudioSuite formats.

Dynamics III supports 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz and 192 kHz sample rates as available on your system. All modules work with mono and stereo formats.

In addition to standard controls in each module, Dynamics III also provides a graph to track the gain transfer curve in the Compressor/Limiter and Expander/Gate plug-ins, and a frequency graph to display which frequencies trigger the De-Esser and which frequencies will be gain reduced.

---

Shared Compressor/Limiter and Expander/Gate Features

The following parts of the user interface are shared between the Compressor/Limiter and Expander/Gate Dynamics III plug-ins.

Levels Section

The indicators and controls in the Levels section let you track input, output, and gain reduction levels, as well as work with phase invert and the threshold setting.

See “De-Esser Levels Section” on page 27 for more information on De-Esser III Input/Output Level controls.
**Input and Output Meters**

The Input (In) and Output (Out) meters show peak signal levels before and after dynamics processing:

- **Green** Indicates nominal levels.
- **Yellow** Indicates pre-clipping levels, starting at –6 dB below full scale.
- **Red** Indicates full scale levels (clipping).

The clip indicators at the top of the Output meters indicate clipping at the input or output stage of the plug-in. Clip indicators can be cleared by clicking the indicator.

💡 *The Input and Output meters display differently depending on the type of track (mono, stereo, or multichannel) on which the plug-in has been inserted.*

💡 *When Side-Chain Listen is enabled, the Output meter only displays the levels of the side-chain signal. See “Side-Chain Listen” on page 29.*

**Toggling Multichannel Input and Output Meters**

With multichannel track types LCRS and higher, both Input and Output meters cannot be shown at the same time. Click either the Input or Output button to display the appropriate level meter. The Input/Output meters display is toggled to Output by default.

**Gain Reduction Meter**

The Gain Reduction (GR) meter indicates the amount the input signal is attenuated (in dB) and shows different colors during dynamics processing:

- **Light Orange** Indicates that gain reduction is within the “knee” and has not reached the full ratio of compression.
- **Dark Orange** Indicates that gain reduction is being applied at the full ratio (for example, 2:1).

**Threshold Arrow**

The orange Threshold arrow next to the Input meter indicates the current threshold, and can be dragged up or down to adjust the threshold. When a multichannel instance of the plug-in has been configured to show only the Output meter, the Threshold arrow is not displayed.

**Phase Invert**

The Phase Invert button inverts the phase (polarity) of the input signal, to help compensate for phase anomalies that can occur either in multi-microphone environments or because of mis-wired balanced connections.
LFE Enable
(Pro Tools HD and Pro Tools LE with Complete Production Toolkit Only)

The LFE Enable button (located in the Options section) is on by default, and enables plug-in processing of the LFE (low frequency effects) channel on a multichannel track formatted for 5.1, 6.1, or 7.1 surround formats. To disable LFE processing, deselect this button.

LFE Enable button (Compressor/Limiter III shown)

💡 The LFE Enable button is not available if the plug-in is not inserted on an applicable track.

Dynamics Graph Display

The Dynamics Graph display—used with the Compressor/Limiter and Expander/Gate plug-ins—shows a curve that represents the level of the input signal (on the x-axis) and the level of the output signal (on the y-axis). The orange vertical line represents the threshold.

Use this graph as a visual guideline to see how much dynamics processing you are applying.

Dynamics graph display

The Compressor/Limiter and Expander/Gate plug-ins also feature an animated, multi-color cursor in their gain transfer curve displays.

The gain transfer curve of the Compressor/Limiter and Expander/Gate plug-ins shows a moving ball cursor that shows the amount of input gain (x-axis) and gain reduction (y-axis) being applied to the incoming signal.

Gain transfer curve and cursor showing amount of compression
To indicate overshoots (when an incoming signal peak is too fast for the current compression setting) the cursor temporarily leaves the gain transfer curve.

The cursor changes color to indicate the amount of compression applied, as follows:

<table>
<thead>
<tr>
<th>Cursor Color</th>
<th>Compression Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>white</td>
<td>no compression</td>
</tr>
<tr>
<td>light orange</td>
<td>below full ratio</td>
</tr>
<tr>
<td>dark orange</td>
<td>full ratio amount</td>
</tr>
</tbody>
</table>

See “De-Esser Frequency Graph Display” on page 28 for information on using the De-Esser’s graph display.

### Side-Chain Section

For information on using the Side-Chain section of the Compressor/Limiter or Expander/Gate, see “Using the Side-Chain Input in Dynamics III” on page 29.

### Compressor/Limiter III

The Compressor/Limiter plug-in applies either compression or limiting to audio material, depending on the ratio of compression used.

Compressor/Limiter III

Compression reduces the dynamic range of signals that exceed a chosen threshold by a specific amount. The Threshold control sets the level that the signal must exceed to trigger compression. The Attack control sets how quickly the compressor responds to the “front” of an audio signal once it crosses the selected threshold. The Release control sets the amount of time that it takes for the compressor’s gain to return to its original level after the input signal drops below the selected threshold.

To use compression most effectively, the attack time should be set so that signals exceed the threshold level long enough to cause an increase in the average level. This helps ensure that gain reduction does not decrease the overall volume too drastically, or eliminate desired attack transients in the program material.

Of course, compression has many creative uses that break these rules.
About Limiting

Limiting prevents signal peaks from ever exceeding a chosen threshold, and is generally used to prevent short-term peaks from reaching their full amplitude. Used judiciously, limiting produces higher average levels, while avoiding overload (clipping or distortion), by limiting only some short-term transients in the source audio. To prevent the ear from hearing the gain changes, extremely short attack and release times are used.

Limiting is used to remove only occasional peaks because gain reduction on successive peaks would be noticeable. If audio material contains many peaks, the threshold should be raised and the gain manually reduced so that only occasional, extreme peaks are limited.

Limiting generally begins with the ratio set at 10:1 and higher. Large ratios effectively limit the dynamic range of the signal to a specific value by setting an absolute ceiling for the dynamic range.

Compressor/Limiter III Controls

This section describes controls for the Compressor/Limiter plug-in.

Input/Output Level Meters

The Input and Output meters show peak signal levels before and after dynamics processing. See “Levels Section” on page 17 for more information.

Unlike scales on analog compressors, metering scales on a digital device reflect a 0 dB value that indicates full scale (fs) — the full-code signal level. There is no headroom above 0 dB.

Compressor/Limiter Graph Display

The Dynamics Graph display lets you visually see how much expansion or gating you are applying to your audio material. See “Dynamics Graph Display” on page 19.

Threshold

The Threshold (Thresh) control sets the level that an input signal must exceed to trigger compression or limiting. Signals that exceed this level will be compressed. Signals that are below it will be unaffected.

This control has an approximate range of –60 dB to 0 dB, with a setting of 0 dB equivalent to no compression or limiting. The default value for the Threshold control is –24 dB.
An orange arrow on the Input meter indicates the current threshold, and can also be dragged up or down to adjust the threshold setting.

**Threshold arrow on input meter**

The Dynamics Graph display also shows the threshold as an orange vertical line.

**Threshold indicator on Dynamics Graph display**

This control ranges from −60 dB (lowest gain) to 0 dB (highest gain).

**Ratio**

The Ratio control sets the compression ratio, or the amount of compression applied as the input signal exceeds the threshold. For example, a 2:1 compression ratio means that a 2 dB increase of level above the threshold produces a 1 dB increase in output.

This control ranges from 1:1 (no compression) to 100:1 (hard limiting).

**Attack**

The Attack control sets the attack time, or the rate at which gain is reduced after the input signal crosses the threshold.

The smaller the value, the faster the attack. The faster the attack, the more rapidly the Compressor/Limiter applies attenuation to the signal. If you use fast attack times, you should generally use a proportionally longer release time, particularly with material that contains many peaks in close proximity.

This control ranges from 10 μs (fastest attack time) to 300 ms (slowest attack time).

**Release**

The Release control sets the length of time it takes for the Compressor/Limiter to be fully deactivated after the input signal drops below the threshold.

Release times should be set long enough that if signal levels repeatedly rise above the threshold, the gain reduction “recovers” smoothly. If the release time is too short, the gain can rapidly fluctuate as the compressor repeatedly tries to recover from the gain reduction. If the release time is too long, a loud section of the audio material could cause gain reduction that continues through soft sections of program material without recovering.

This control ranges from 5 ms (fastest release time) to 4 seconds (slowest release time).
Knee

The Knee control sets the rate at which the compressor reaches full compression once the threshold has been exceeded.

As you increase this control, it goes from applying “hard-knee” compression to “soft-knee” compression:

- With hard-knee compression, compression begins when the input signal exceeds the threshold. This can sound abrupt and is ideal for limiting.
- With soft-knee compression, gentle compression begins and increases gradually as the input signal approaches the threshold, and reaches full compression after exceeding the threshold. This creates smoother compression.

For example, a Knee setting of 10 dB would be the gain range over which the ratio gradually increased to the set ratio amount.

The Gain Reduction meter displays light orange while gain reduction has not exceeded the knee setting, and switches to dark orange when gain reduction reaches the full ratio.

This control ranges from 0 dB (hardest response) to 30 db (softest response).

Gain

The Gain control lets you boost overall output gain to compensate for heavily compressed or limited signals.

This control ranges from 0 dB (no gain boost) to +40 dB (loudest gain boost), with the default value at 0 dB.

For more information on the LFE channel, refer to the Pro Tools Reference Guide.

Side-Chain Section

The side-chain is the split-off signal used by the plug-in’s detector to trigger dynamics processing. The Side-Chain section lets you toggle the side-chain between the internal input signal or an external key input, and tailor the equalization of the side-chain signal so that the triggering of dynamics processing becomes frequency-sensitive. See “Using the Side-Chain Input in Dynamics III” on page 29.
Expander/Gate III

The Expander/Gate plug-in applies expansion or gating to audio material, depending on the ratio setting.

Expander/Gate III

About Expansion

Expansion decreases the gain of signals that fall below a chosen threshold. They are particularly useful for reducing noise or signal leakage that creeps into recorded material as its level falls, as often occurs in the case of headphone leakage.

About Gating

Gating silences signals that fall below a chosen threshold. To enable gating, simply set the Ratio and Range controls to their maximum values.

Expanders can be thought of as soft noise gates since they provide a gentler way of reducing noisy low-level signals than the typically abrupt cutoff of a gate.

Expander/Gate III Controls

This section describes controls for the Expander/Gate plug-in.

Input/Output Level Meters

The Input and Output meters show peak signal levels before and after dynamics processing. See “Levels Section” on page 17 for more information.

Expander/Gate Dynamics Graph Display

The Dynamics Graph display lets you visually see how much expansion or gating you are applying to your audio material. See “Dynamics Graph Display” on page 19.

Look Ahead Button

Normally, dynamics processing begins when the level of the input signal crosses the threshold. When the Look Ahead button is enabled, dynamics processing begins 2 milliseconds before the level of the input signal crosses the threshold.

Look Ahead control

The Look Ahead control is useful for avoiding the loss of transients that may have been otherwise cut off or trimmed in a signal.
Threshold

The Threshold (Thresh) control sets the level below which an input signal must fall to trigger expansion or gating. Signals that fall below the threshold will be reduced in gain. Signals that are above it will be unaffected.

An orange arrow on the Input meter indicates the current threshold, and can also be dragged up or down to adjust the threshold setting.

Ratio

The Ratio control sets the amount of expansion. For example, if this is set to 2:1, it will lower signals below the threshold by one half. At higher ratio levels (such as 30:1 or 40:1) the Expander/Gate functions like a gate by cutting off signals that fall below the threshold. As you adjust the ratio control, refer to the built-in graph to see how the shape of the expansion curve changes.

This control ranges from 1:1 (no expansion) to 100:1 (gating).

Attack

The Attack control sets the attack time, or the rate at which gain is reduced after the input signal crosses the threshold. Use this along with the Ratio setting to control how soft the Expander’s gain reduction curve is.

This control ranges from 10 μs (fastest attack time) to 300 ms (slowest attack time).

Hold

The Hold control specifies the duration (in seconds or milliseconds) during which the Expander/Gate will stay in effect after the initial attack occurs. This can be used as a function to keep the Expander/Gate in effect for longer periods of time with a single crossing of the threshold. It can also be used to prevent gate chatter that may occur if varying input levels near the threshold cause the gate to close and open very rapidly.

This control ranges from 5 ms (shortest hold) to 4 seconds (longest hold).
**Release**

The Release control sets how long it takes for the gate to close after the input signal falls below the threshold level and the hold time has passed.

This control ranges from 5 ms (fastest release time) to 4 seconds (slowest release time).

**Range**

The Range control sets the depth of the Expander/Gate when closed. Setting the gate to higher range levels allows more and more of the gated audio that falls below the threshold to peek through the gate at all times.

This control ranges from –80 dB (lowest depth) to 0 dB (highest depth).

**Side-Chain Section**

The side-chain is the split-off signal used by the plug-in’s detector to trigger dynamics processing. The Side-Chain section lets you toggle the side-chain between the internal input signal or an external key input, and tailor the equalization of the side-chain signal so that the triggering of dynamics processing becomes frequency-sensitive. See “Using the Side-Chain Input in Dynamics III” on page 29.

---

**De-Esser III**

The De-Esser reduces sibilants and other high frequency noises that can occur in vocals, voice-overs, and wind instruments such as flutes. These sounds can cause peaks in an audio signal and lead to distortion.

The De-Esser reduces these unwanted sounds using fast-acting compression. The Threshold control sets the level above which compression starts, and the Frequency (Freq) control sets the frequency band in which the De-Esser operates.
Using De-Essing Effectively

To use de-essing most effectively, insert the De-Esser after compressor or limiter plug-ins.

The Frequency control should be set to remove sibilants (typically the 4–10 kHz range) and not other parts of the signal. This helps prevent de-essing from changing the original character of the audio material in an undesired manner.

Similarly, the Range control should be set to a level low enough so that de-essing is triggered only by sibilants. If the Range is set too high, a loud, non-sibilant section of audio material could cause unwanted gain reduction or cause sibilants to be over-attenuated.

To improve de-essing of material that has both very loud and very soft passages, automate the Range control so that it is lower on soft sections.

💡 The De-Esser has no control to directly adjust the threshold level (the level that an input signal must exceed to trigger de-essing). The amount of de-essing will vary with the input signal.

De-Esser III Controls

This section describes controls for the De-Esser plug-in.

De-Esser Levels Section

These controls let you track input, output, and gain reduction levels.

De-Esser III I/O Meter display

Input and Output Meters

The Input and Output meters show peak signal levels before and after dynamics processing:

**Green** Indicates nominal levels.

**Yellow** Indicates pre-clipping levels, starting at –6 dB below full scale.

**Red** Indicates full scale levels (clipping).

The Clip indicators at the top of each meter indicate clipping at the input or output stage of the plug-in. Clip indicators can be cleared by clicking the indicator.
**Gain Reduction Meter**

The Gain Reduction meter indicates the amount the input signal is attenuated, in dB. This meter shows different colors during de-essing:

**Light Orange** Indicates that gain reduction is being applied, but has not reached the maximum level set by the Range control.

**Dark Orange** Indicates that gain reduction has reached the maximum level set by the Range control.

**Frequency**

The Frequency (Freq) control sets the frequency band in which the De-Esser operates. When HF Only is disabled, gain is reduced in frequencies within the specified range. When HF Only is enabled, the gain of frequencies above the specified value will be reduced.

This control ranges from 500 Hz (lowest frequency) to 16 kHz (highest frequency).

**Range**

The Range control defines the maximum amount of gain reduction possible when a signal is detected at the frequency set by the Frequency control.

This control ranges from –40 dB (maximum de-essing) to 0 dB (no de-essing).

**HF Only**

When the HF Only button is enabled, gain reduction is applied only to the active frequency band set by the Frequency control. When the HF Only button is disabled, the De-Esser applies gain reduction to the entire signal.

**Listen**

When enabled, the Listen button lets you monitor the sibilant peaks used by the De-Esser as a side-chain to trigger compression. This is useful for listening only to the sibilance for fine-tuning De-Esser controls. To monitor the whole output signal without this filtering, deselect the Listen button.

**De-Esser Frequency Graph Display**

The De-Esser Frequency Graph display shows a curve that represents the level of gain reduction (on the y-axis) for the range of the output signal’s frequency (on the x-axis). The white line represents the current Frequency setting, and the animated orange line represents the level of gain reduction being applied to the signal.

Use this graph as a visual guideline to see how much dynamics processing you are applying at different points in the frequency spectrum.
Using the Side-Chain Input in Dynamics III

(Compressor/Limiter and Expander/Gate Only)

Dynamics processors typically use the detected amplitude of their input signal to trigger gain reduction. This split-off signal is known as the side-chain. The Compressor/Limiter and Expander/Gate plug-ins feature external key capabilities and filters for the side-chain.

With external key side-chain processing, you trigger dynamics processing using an external signal (such as a separate reference track or audio source) instead of the input signal. This external source is known as the key input.

With side-chain filters, you can make dynamics processing more or less sensitive to certain frequencies. For example, you might configure the side-chain so that certain lower frequencies on a drum track trigger dynamics processing.

Side-Chain Section

The Side-Chain section lets you toggle the side-chain between the internal input signal or an external key input, listen to the side-chain, and tailor the equalization of the side-chain signal so that the triggering of dynamics processing becomes frequency-sensitive.

External Key

The External Key toggles external side-chain processing on or off. When this button is highlighted, the plug-in uses the amplitude of a separate reference track or external audio source to trigger dynamics processing. When this button is dark gray, the External Key is disabled and the plug-in uses the amplitude of the input signal to trigger dynamics processing.

Side-Chain Listen

When enabled, this control lets you listen to the internal or external side-chain input by itself, as well as monitor its levels with the Output meter. This is especially useful for fine-tuning the plug-in’s filter settings or external key input.

⚠️ Side-Chain Listen is not saved with other plug-in presets.
**HF and LF Filter Enable Buttons**

The HF Filter Enable and LF Filter Enable buttons toggle the corresponding filter in or out of the side-chain. When this button is highlighted, the filter is applied to the side-chain signal. When this button is dark gray, the filter is bypassed and available for activation.

**HF Frequency Control**

The Frequency control sets the frequency position for the Band-Pass or Low-Pass filter, and ranges from 80 Hz to 20 kHz.

**Low-Frequency (LF) Filter Type**

The LF filter section lets you filter lower frequencies out of the side-chain signal so that only certain bands of low frequencies or higher frequencies are allowed to pass through to trigger dynamics processing. The LF side-chain is switchable between Band-Pass and High-Pass filters.

**Band-Pass Filter** Makes triggering of dynamics processing more sensitive to frequencies within the narrow band centered around the Frequency setting, and rolling off at a slope of 12 dB per octave.

**High-Pass Filter** Makes triggering of dynamics processing more sensitive to frequencies above the Frequency setting rolling off at a slope of 12 dB per octave.

**LF Frequency Control**

The Frequency control sets the frequency position for the Band-Pass or High-Pass filter, and ranges from 25 Hz to 4 kHz.
Using an External Key Input for Side-Chain Processing

To use a filtered or unfiltered external key input to trigger dynamics processing:

1. Click the Key Input selector and select the input or bus carrying the audio from the reference track or external audio source.

2. Click External Key to activate external side-chain processing.

3. To listen to the signal that will be used to control side-chain input, click Side-Chain Listen to enable it (highlighted).

4. To filter the key input so that only specific frequencies trigger the plug-in, use the HF and LF controls to select the desired frequency range.

5. Begin playback. The plug-in uses the input or bus that you chose as an external key input to trigger its effect.

6. Adjust the plug-in’s Threshold (Thresh) control to fine-tune external key input triggering.

7. Adjust other controls to achieve the desired effect.

Using a Filtered Input Signal for Side-Chain Processing

To use the filtered input signal to trigger dynamics processing:

1. Ensure the Key Input selector is set to No Key Input.

2. Ensure that the External Key button is disabled (dark gray).

3. To listen to the signal that will be used to control side-chain input, click Side-Chain Listen to enable it (highlighted).

4. To filter the side-chain input so that only specific frequencies within the input signal trigger the plug-in, use the HF and LF controls to select the desired frequency range.

5. Begin playback. The plug-in uses the filtered input signal to trigger dynamics processing.

6. To fine-tune side-chain triggering, adjust the plug-in controls.
Chapter 6

EQ III

(RTAS and AudioSuite)

The EQ III plug-in provides a high-quality 7 Band, 2–4 Band, or 1 Band EQ for adjusting the frequency spectrum of audio material.

EQ III is available in the following formats:

- 7 Band: RTAS and AudioSuite
- 2–4 Band: RTAS only
- 1 Band: RTAS and AudioSuite

EQ III supports all Pro Tools session sample rates, and operates as a mono, multi-mono, or stereo plug-in.

EQ III has a Frequency Graph display that shows the response curve for the current EQ settings on a two-dimensional graph of frequency and gain. The frequency graph display also lets you modify frequency, gain and Q settings for individual EQ bands by dragging their corresponding points in the graph.

By choosing from the 7 Band, 2–4 Band, or 1 Band versions of the EQ III plug-in, you can use only the number of EQ bands you need for each track, conserving DSP capacity on Pro Tools|HD systems.

EQ III Configurations

The EQ III plug-in appears as three separate choices in the plug-in insert pop-up menu and in the AudioSuite menu:

- 1 Band (“1-Band EQ 3”)
- 2–4 Band (“4-Band EQ 3”)
- 7 Band (“7-Band EQ 3”)

Chapter 6: EQ III  33
**1 Band EQ**

The 1 Band EQ is available in RTAS and AudioSuite formats.

The 1 Band EQ has its own window, with six selectable filter types.

**7 Band EQ and 2–4 Band EQ**

The 7 Band EQ is available in RTAS and AudioSuite formats. The 2–4 Band EQ is available in RTAS format only.

The 7 Band EQ and the 2–4 Band EQ share the same window and identical controls, but with the 2–4 Band EQ, a limited number of the seven available bands can be active at the same time.

---

### EQ III Controls

#### Adjusting EQ III Controls

You can adjust the EQ III plug-in controls by any of the following methods:

**Dragging Plug-in Controls**

The rotary controls on the EQ III plug-in can be adjusted by dragging over them horizontally or vertically. Dragging up or to the right increments the control. Dragging down or to the left decrements the control.

**Typing Control Values**

You can enter control values directly by clicking in the corresponding text box, typing a value, and pressing Enter (Windows) or Return (Mac).

**Inverting Filter Gain**

(Peak EQ Bands Only)

Gain values can be inverted on any Peak EQ band by Shift-clicking its control dot in the Frequency Graph display, or its Gain knob in the plug-in window. This changes a gain boost to a cut (+9 to –9) or a gain cut to a boost (–9 to +9). Gain values cannot be inverted on Notch, High-Pass, Low-Pass, or shelving bands.
Dragging in the Frequency Graph Display

You can adjust the following by dragging the control points directly in the Frequency Graph display:

**Frequency** Dragging a control point to the right increases the Frequency setting. Dragging a control point to the left decreases the Frequency setting.

**Gain** Dragging a control point up increases the Gain setting. Dragging a control point down decreases the Gain setting.

**Q** Start-dragging (Windows) or Control-dragging (Mac) a control point up increases the Q setting. Start-dragging (Windows) or Control-dragging (Mac) a control point down decreases the Q setting.

---

Resetting Controls to Default Values

You can reset any on-screen control to its default value by Alt-clicking (Windows) or Option-clicking (Mac OS) directly on the control or on its corresponding text box.

Using Band-Pass Mode

You can temporarily set any EQ III control to Band-Pass monitoring mode. Band-Pass mode cuts monitoring frequencies above and below the Frequency setting, leaving a narrow band of mid-range frequencies. It is especially useful for adjusting limited bandwidth in order to solo and fine-tune each individual filter before reverting the control to notch filter or peaking filter type operations.

*Band-Pass mode does not affect EQ III Gain controls.*

To switch an EQ III control to Band-Pass mode:

- Hold Start+Shift (Windows) or Control+Shift (Mac), and drag any rotary control or control point horizontally or vertically.

---

Adjusting Controls with Fine Resolution

Controls and control points can be adjusted with fine resolution by holding the Control key (Windows) or the Command key (Mac) while adjusting the control.

---

When monitoring in Band-Pass mode, the Frequency and Q controls function differently.

**Frequency** Sets the frequency above and below which other frequencies are cut off, leaving a narrow band of mid-range frequencies.
Q Sets the width of the narrow band of mid-range frequencies centered around the Frequency setting.

To switch an EQ III control out of Band-Pass mode:
- Release Start+Shift (Windows) or Control+Shift (Mac).

I/O Controls

The following Input and Output controls are found on all EQ III configurations, except where noted otherwise.

Output Gain Control
(7 Band EQ and 2–4 Band EQ Only)

The Output Gain control sets the output gain after EQ processing, letting you make up gain or prevent clipping on the channel where the plug-in is being used.

Input Polarity Control

The Input Polarity button inverts the polarity of the input signal, to help compensate for phase anomalies occurring in multi-microphone environments, or because of mis-wired balanced connections.

Input and Output Meters
(7 Band EQ and 2–4 Band EQ Only)

The plasma-style Input and Output meters show peak signal levels before and after EQ processing, and indicate them as follows:

Green Indicates nominal levels
Yellow Indicates pre-clipping levels, starting at –6 dB below full scale
Red Indicates full scale levels (clipping)

When using the stereo version of EQ III, the Input and Output meters display the sum of the left and right channels.

The Clip indicators at the far right of each meter indicate clipping at the input or output stage of the plug-in. Clip indicators can be cleared by clicking the indicator.
**EQ Band Controls**

The individual EQ bands on each EQ III configuration have some combination of the following controls, as noted below.

**EQ Type Selector**

On the 1 Band EQ, the EQ Type selector lets you choose any one of six available filter types: High-Pass, Notch, High-Shelf, Low-Shelf, Peak, and Low-Pass.

On the 7 Band EQ and the 2–4 Band EQ, the HPF, LPF, LF, and HF sections have EQ Type selectors to toggle between the two available filter types in each section.

**Band Enable Button**

*(7 Band EQ and 2–4 Band EQ Only)*

The Band Enable button on each EQ band toggles the corresponding band in and out of circuit. When a Band Enable button is highlighted, the band is in circuit. When a Band Enable button is dark gray, the band is bypassed and available for activation. On the 2–4 Band EQ, when a Band Enable button is light gray, the band is bypassed and unavailable.

**Band Gain Control**

Each Peak and Shelf EQ band has a Gain control for boosting or cutting the corresponding frequencies. Gain controls are not used on High-Pass, Low-Pass, or Notch filters.

**Frequency Control**

Each EQ band has a Frequency control that sets the center frequency (Peak, Shelf and Notch EQs) or the cutoff frequency (High-Pass and Low-Pass filters) for that band.

**Q Control**

**Peak and Notch** On Peak and Notch bands, the Q control changes the width of the EQ band. Higher Q values represent narrower bandwidths. Lower Q values represent wider bandwidths.

**Shelf** On Shelf bands, the Q control changes the Q of the shelving filter. Higher Q values represent steeper shelving curves. Lower Q values represent broader shelving curves.

**Band Pass** On High-Pass and Low-Pass bands, the Q control lets you select from any of the following Slope values: 6 dB, 12 dB, 18 dB, or 24 dB per octave.
**Frequency Graph Display**  
*(7 Band EQ and 2–4 Band EQ Only)*

The Frequency Graph display in the 7 Band EQ and the 2–4 Band EQ shows a color-coded control dot that corresponds to the color of the Gain control for each band. The filter shape of each band is similarly color-coded. The white frequency response curve shows the contribution of each of the enabled filters to the overall EQ curve.

---

**Frequency Graph display for the 7 Band EQ**
Chapter 6: EQ III

7 Band EQ

The 7 Band EQ has the following available bands: High-Pass/Low Notch, Low-Pass/High Notch, Low Shelf/Low Peak, Low-Mid Peak, Mid Peak, High-Mid Peak, and High Shelf/High Peak.

All seven bands are available for simultaneous use. In the factory default setting, the High-Pass/Low Notch and Low-Pass/High Notch bands are out of circuit, the Low Shelf and High Shelf bands are selected and in circuit, and the Low-Mid Peak, Mid Peak, High-Mid Peak bands are in circuit.

7 Band EQ and 2–4 Band EQ window

High-Pass/Low Notch

The 7 Band EQ has the following available bands: High-Pass/Low Notch, Low-Pass/High Notch, Low Shelf/Low Peak, Low-Mid Peak, Mid Peak, High-Mid Peak, and High Shelf/High Peak.
The High-Pass/Notch band is switchable between high-pass filter and notch EQ functions. By default, this band is set to High-Pass Filter.

**High-Pass Filter** Attenuates all frequencies below the Frequency setting at the selected slope while letting all frequencies above pass through.

**Low-Notch EQ** Attenuates a narrow band of frequencies centered around the Frequency setting. The width of the attenuated band is determined by the Q setting.

The High Pass and Low Notch controls and their corresponding graph elements are displayed on-screen in gray.

**High-Pass Filter and Low Notch EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>20 Hz to 8 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>20 Hz</td>
</tr>
<tr>
<td>HPF Slope Values</td>
<td>6, 12, 18, or 24 dB/oct</td>
</tr>
<tr>
<td>Low Notch Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Low Notch Q Default</td>
<td>1.0</td>
</tr>
</tbody>
</table>

The Low-Pass/Notch band is switchable between low-pass filter and notch EQ functions. By default, this band is set to Low-Pass Filter.

**Low-Pass Filter** Attenuates all frequencies above the Frequency setting at the selected slope while letting all frequencies below pass through.

**High-Notch EQ** Attenuates a narrow band of frequencies centered around the Frequency setting. The width of the attenuated band is determined by the Q setting.

The Low Pass and High Notch controls and their corresponding graph elements are displayed on-screen in gray.

**Low-Pass Filter and High Notch EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>120 Hz to 20 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>20 kHz</td>
</tr>
<tr>
<td>LPF Slope Values</td>
<td>6, 12, 18, or 24 dB/oct</td>
</tr>
<tr>
<td>High Notch Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>High Notch Q Default</td>
<td>1.0</td>
</tr>
</tbody>
</table>
**Low Shelf/Low Peak**

The Low Shelf/Peak band is switchable between low shelf EQ and low peak EQ functions. By default, this band is set to Low Shelf.

**Low-Shelf EQ** Boosts or cuts frequencies at and below the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.

**Low Peak EQ** Boosts or cuts a band of frequencies centered around the Frequency setting. The width of the affected band is determined by the Q setting.

The Low Shelf and Low Peak Gain controls and their corresponding graph elements are displayed on-screen in red.

**Low Shelf EQ and Low Peak EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>20 Hz to 500 Hz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>100 Hz</td>
</tr>
<tr>
<td>Low Shelf Q Range</td>
<td>0.1 to 2.0</td>
</tr>
<tr>
<td>Low Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>Low Shelf Gain Range</td>
<td>-12 dB to +12 dB</td>
</tr>
<tr>
<td>Low Peak Gain Range</td>
<td>-18 dB to +18 dB</td>
</tr>
</tbody>
</table>

*Low Shelf EQ (left) and Low Peak EQ (right)*
Low-Mid Peak

The Low-Mid Peak band boosts or cuts frequencies centered around the Frequency setting. The width of the band is determined by the Q setting.

Low-Mid Peak EQ

The Low-Mid Gain control and its corresponding graph elements are displayed on-screen in brown.

**Low-Mid Peak EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>40 Hz to 1 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>200 Hz</td>
</tr>
<tr>
<td>Low-Mid Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Low-Mid Peak Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>Low-Mid Peak Gain Range</td>
<td>-18 dB to +18 dB</td>
</tr>
</tbody>
</table>

Mid Peak

The Mid Peak band boosts or cuts frequencies centered around the Frequency setting. The width of the band is determined by the Q setting.

Mid Peak EQ

The Mid Gain control and its corresponding graph elements are displayed on-screen in yellow.

**Mid Peak EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>125 Hz to 8 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>1 kHz</td>
</tr>
<tr>
<td>Mid Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Mid Peak Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>Mid Peak Gain Range</td>
<td>-18 dB to +18 dB</td>
</tr>
</tbody>
</table>
**High-Mid Peak**

The High-Mid Peak band boosts or cuts frequencies centered around the Frequency setting. The width of the band is determined by the Q setting.

**High-Shelf/High Peak**

The High Shelf/Peak band is switchable between high shelf EQ and high peak EQ functions. By default, this band is set to High Shelf.

**High-Shelf EQ** Boosts or cuts frequencies at and above the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.

**High Peak EQ** Boosts or cuts a band of frequencies centered around the Frequency setting. The width of the affected band is determined by the Q setting.

---

**High-Mid Peak EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>200 Hz to 18 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>2 kHz</td>
</tr>
<tr>
<td>Mid Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Mid Peak Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>Mid Peak Gain Range</td>
<td>-18 dB to +18 dB</td>
</tr>
</tbody>
</table>

*High Shelf EQ (left) and High Peak EQ (right)*
The High Shelf and High Peak Gain controls and their corresponding graph elements are displayed on-screen in blue.

**High Shelf EQ and High Peak EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>1.8 kHz to 20 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>6 kHz</td>
</tr>
<tr>
<td>High Shelf Q Range</td>
<td>0.1 to 2.0</td>
</tr>
<tr>
<td>High Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>High Shelf Gain Range</td>
<td>–12 dB to +12 dB</td>
</tr>
<tr>
<td>High Peak Gain Range</td>
<td>–18 dB to +18 dB</td>
</tr>
</tbody>
</table>

**2–4 Band EQ**

The 2–4 Band EQ uses the same plug-in window as the 7 Band EQ, but on the 2–4 Band EQ, but a limited number of the seven available bands can be active at the same time.

In the factory default setting, the High-Pass/Low Notch, Low-Pass/High Notch and Mid Peak bands are out of circuit, the Low Shelf and High Shelf bands are selected and in circuit, and the Low-Mid Peak and High-Mid Peak bands are in circuit.

Additional EQ bands can then be enabled to add them to the settings inherited from the 2–4 Band plug-in.

### Filter Usage with 2–4 Band EQs

With a 2–4 Band EQ, a maximum of four filters may be active simultaneously, with each of the five Peak bands (Low Shelf/Peak, Low-Mid Peak, Mid-Peak, High-Mid Peak and High Shelf/Peak) counting as one filter. Each of the Band-pass and Notch filters (High-Pass, Low Notch, Low-Pass and High-Notch) counts as two filters.

When any combination of these filter types uses the four-filter maximum on the 2–4 Band EQ, the remaining bands become unavailable. This is indicated by the Band Enable buttons turning light gray. When filters become available again, the Band Enable button on inactive bands turns dark gray.

### Switching Between the 2–4 Band EQ and 7 Band EQ

When you switch an existing EQ III plug-in between the 2–4 Band and 7 Band versions, or when you import settings between versions, the change is subject to the following conditions:

### Changing from 7 Band to 2–4 Band

After switching from a 7 band EQ to a 2–4 Band EQ, or importing settings from a 7 Band EQ, all control settings from the 7 Band EQ are preserved, and the bands in the 7 Band EQ inherit their enabled or bypassed state from the 2–4 Band plug-in.

For Pro Tools HD, using a 2–4 Band EQ instead of a 7 Band EQ saves DSP resources.

### Changing from 2–4 Band to 7 Band

After switching from a 2–4 band EQ to a 7 Band EQ, or importing settings from a 2–4 Band EQ, all control settings from the 2–4 Band EQ are preserved, and the bands in the 7 Band EQ inherit their enabled or bypassed state from the 2–4 Band plug-in.
**1 Band EQ**

The Frequency Graph display in the 1 Band EQ shows a control dot that indicates the center frequency (Peak, Shelf and Notch Filters) or the cutoff frequency (High-Pass and Low-Pass filters) for the currently selected filter type.

**Band Controls**

The individual EQ types have some combination of the following controls, as noted below.

**1 Band EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range (All)</td>
<td>20 Hz to 20 kHz</td>
</tr>
<tr>
<td>Frequency Default (All)</td>
<td>1 kHz</td>
</tr>
<tr>
<td>Q Range (Low/High Shelf)</td>
<td>0.1 to 2.0</td>
</tr>
<tr>
<td>Q Range (Peak/Notch)</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Q Default (All)</td>
<td>1.0</td>
</tr>
<tr>
<td>Gain Range (Low/High Shelf)</td>
<td>–12 dB to +12 dB</td>
</tr>
<tr>
<td>High Peak Gain Range</td>
<td>–18 dB to +18 dB</td>
</tr>
</tbody>
</table>

**EQ Types**

**High-Pass Filter**

The High-Pass filter attenuates all frequencies below the Frequency setting at the selected rate (6 dB, 12 dB, 18 dB, or 24 dB per octave) while letting all frequencies above pass through. No gain control is available for this filter type.

The 1 Band EQ may be set to any one of six EQ types: High-Pass, Notch, High-Shelf, Low-Shelf, Peak, and Low-Pass, by clicking the corresponding icon in the EQ Type selector.
**Notch Filter**

The Notch Filter attenuates a narrow band of frequencies centered around the Frequency setting. No gain control is available for this EQ type. The width of the attenuated band is determined by the Q setting.

**High-Shelf EQ**

The High-Shelf EQ boosts or cuts frequencies at and above the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.

**Low-Shelf EQ**

The Low-Shelf EQ boosts or cuts frequencies at and below the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.

**Peak EQ**

The Peak EQ boosts or cuts a band of frequencies centered around the Frequency setting. The width of the affected band is determined by the Q setting.
**Low-Pass Filter**

The Low-Pass filter attenuates all frequencies above the cutoff frequency setting at the selected rate (6 dB, 12 dB, 18 dB, or 24 dB per octave) while letting all frequencies below pass through. No gain control is available for this filter type.

1 Band EQ set to Low-Pass Filter
There are six different Mod Delay II plug-ins, capable of different maximum delay times:

- The AudioSuite only version of the Delay plug-in provides up to 10.9 seconds of delay at all sample rates.
- The Short Delay provides 43 ms of delay at all sample rates.
- The Slap Delay provides 171 ms of delay at all sample rates.
- The Medium Delay provides 341 ms of delay at all sample rates.
- The Long Delay provides 683 ms of delay at all sample rates.
- The Extra Long Delay provides 2.73 seconds of delay at all sample rates.

⚠️ Short Delay and Slap Delay do not have Tempo, Meter, Duration, and Groove controls.

- The Medium Delay provides 341 ms of delay at all sample rates.
- The Long Delay provides 683 ms of delay at all sample rates.
- The Extra Long Delay provides 2.73 seconds of delay at all sample rates.

Mod Delay II Controls

- **Input** Controls the input volume of the delay to prevent clipping.
- **Mix** Controls the balance between the delayed signal (wet) and the original signal (dry). If you are using a delay for flanging or chorusing, you can control the depth of the effect somewhat with the Mix setting.
LPF (Low-Pass Filter) Controls the cutoff frequency of the Low-Pass Filter. Use the LPF setting to attenuate the high frequency content of the feedback signal. The lower the setting, the more high frequencies are attenuated. The maximum value for LPF is Off. This lets the signal pass through without limiting the bandwidth of the plug-in.

**Delay** Sets the delay time between the original signal and the delayed signal.

**Depth** Controls the depth of the modulation applied to the delayed signal.

**Rate** Controls the rate of modulation of the delayed signal.

**Feedback** Controls the amount of feedback applied from the output of the delay back into its input. It also controls the number of repetitions of the delayed signal. Negative feedback settings give a more intense “tunnel-like” sound to flanging effects.

**Tempo Sync** Provides a direct connection between the Pro Tools session tempo and plug-in controls that support MIDI Beat Clock (such as Delay). This direct connection lets plug-in parameters such as delay, automatically synchronize to, and follow changes in, session tempo.

When Tempo Sync is enabled, the Tempo and Meter controls are uneditable and follow the session tempo and meter changes. The Duration and Groove controls apply when Tempo Sync is enabled.

**To enable Tempo Sync:**

- Click the Tempo Sync icon. The tempo shown changes to match the current session tempo and the meter changes to match the current meter.

When Tempo Sync is enabled, the Tempo control is unavailable.

**Meter** Use this to enter either simple or compound time signatures. The Meter control defaults to a 4/4 time signature.

When Tempo Sync is enabled, the Meter control is unavailable.
**Duration** Specifies a desired delay from a musical perspective. Enter the desired delay by selecting appropriate note value (whole note, half note, quarter note, eight note, or sixteenth note). Select the Dot or Triplet modifier buttons to dot the selected note value or make it a triplet. For example, selecting a quarter note and then selecting the dot indicates a dotted quarter note, and selecting an eighth note and then selecting the triplet indicates a triplet eighth note.

**Groove** Provides fine adjustment of the delay in percentages of a 1:4 subdivision of the beat. It can be used to add “swing” by slightly offsetting the delay from the precise beat of the track.

⚠️ **It is not possible to exceed the maximum delay length for a particular version of Mod Delay II. Consequently, when adjusting any of the tempo controls (Tempo, Meter, Duration, and Groove) you may not be able to adjust the control across its full range. If you encounter this behavior, switch to a version of Mod Delay II that has a longer delay time (for example, switch from Medium Delay to Long Delay).**

**Multichannel Mod Delay II**

The Tempo and Meter controls are linked on multichannel versions of Mod Delay II. Each channel has its own Duration and Groove controls, but the Tempo and Meter controls are global.

**Selections for ModDelay II AudioSuite Processing**

Because AudioSuite Delay adds additional material (the delayed audio) to the end of selected audio, make a selection that is longer than the original source material to allow the additional delayed audio to be written into the end of the audio file.

Selecting only the original material, without leaving additional space at the end, will cause delayed audio that occurs after the end of the region to be cut off.
Pro Tools M-Powered Essential supports ReWire version 2.0 technology developed by Propellerheads Software. ReWire is available using the Essential ReWire RTAS plug-in.

ReWire provides real-time audio and MIDI streaming between applications, with sample-accurate synchronization and common transport functionality.

Compatible ReWire client applications are automatically detected by Pro Tools and are available in the RTAS Plug-ins Insert menus in Pro Tools. Selecting a ReWire client application within Pro Tools automatically launches that application (if the client application supports this feature). Any corresponding MIDI nodes for that application are available in any Instrument track’s MIDI Output selector (Instrument view) and any MIDI track’s Output selector.

Not all ReWire client applications support automatic launch from a ReWire-mixer application. For these applications, launch the ReWire client application separately, and then select it as a plug-in insert in Pro Tools.

Once the outputs of your software synthesizers and samplers are routed to Pro Tools, you can:

- Process incoming audio signals with plugins
- Automate volume, pan, and plug-in controls
- Bounce To Disk
- Take advantage of the audio outputs of your Digidesign audio interfaces

Exchange of additional metadata such as controller and note names between Pro Tools and ReWire clients is not supported.
Figure 1. Audio and MIDI signal flow between Pro Tools and a ReWire client application (Torq LE shown)
ReWire Requirements

To use the ReWire plug-in, you will need:

- A qualified Pro Tools system
- ReWire-compatible client software (such as Reason from Propellerheads Software)

⚠️ Client software must support the same sample rate as the session using ReWire. For example, third-party client software that does not support sample rates beyond 48 kHz cannot be used in 96 kHz Pro Tools sessions.

ReWire support is also under development for other third-party companies. For availability, check with the manufacturer or visit the Digidesign website (www.digidesign.com).

Using ReWire

The ReWire plug-in is installed when you install Pro Tools. All inter-application communications between Pro Tools and ReWire client software is handled automatically.

To use a ReWire client application with Pro Tools:

1. Make sure that the ReWire client application is installed properly and that you have restarted your computer.

2. In Pro Tools, choose Track > New and specify one Instrument track (or audio or Auxiliary Input track), and click Create.

3. In the Mix window, click the Insert selector on the track and assign the ReWire RTAS client plug-in to the track insert.

4. Configure the ReWire client application to play the sounds you want.

5. In Pro Tools, set the output of the client application in the ReWire plug-in window. This is the audio output of the ReWire client to Pro Tools.

The ReWire client application launches automatically in the background (if the client applications supports auto-launch).

💡 If the client application does not support auto-launch, launch it manually. Some ReWire client applications may need to be launched and configured before launching Pro Tools (such as Cycling 74’s MAX/MSP). Others may need to be launched after Pro Tools is launched (such as Ableton Live). For more information, consult the manufacturer’s documentation for your ReWire client application.
6 In the Mix window, click the track’s MIDI Output selector a and select the ReWire client application. Some ReWire clients (such as Reason) may list multiple devices. If so, choose the device that you want.

7 Choose Options > MIDI Thru and record enable the MIDI track. Play some notes on your MIDI controller to trigger the client application.

The selected ReWire device responds to MIDI sent from Pro Tools and plays back audio through the assigned Pro Tools track (Instrument, Auxiliary Input, or audio track).

If your ReWire client application is a sequencer and you want to begin synchronized playback with Pro Tools, press the Spacebar or click the Play button on the Pro Tools Transport.

⚠️ If you experience system performance problems while using Pro Tools with ReWire client applications, you may need to increase the Pro Tools CPU Usage Limit.

---

**MIDI Automation with ReWire**

You can use Pro Tools MIDI tracks to record MIDI continuous controller (CC) data from a ReWire client application, and then play back MIDI from Pro Tools to send the recorded MIDI CC data back to the ReWire client application. In this way, you can adjust parameters in the ReWire client application (using the mouse or an external MIDI controller) and record those changes in Pro Tools.

**Recording MIDI Continuous Controller Data Over ReWire**

The first step in automating a ReWire client application’s parameters is to record the CC data to a MIDI track in Pro Tools.
To record MIDI from a ReWire client application in Pro Tools:

1. In Pro Tools, create a new MIDI track.
2. From the track's MIDI Input selector, select the ReWire device that you want to record.
3. Record enable the MIDI track.
5. Switch to the ReWire client application.
6. Adjust the parameter for which you want to record MIDI CC data. Parameter changes are recorded to the Pro Tools MIDI track as CC data.

7. When you are done adjusting the parameter, return to Pro Tools and stop recording.
8. Record disable the MIDI track.
9. From the MIDI Track View selector in the Edit window, select the view for the CC data you just recorded.

⚠️ You must select the ReWire device from which you want to record MIDI controller data. Leaving the track’s MIDI Input set to All does not record any MIDI data over ReWire.

If your external MIDI controller is correctly mapped to the corresponding ReWire client application's parameters, and it is correctly routed through Pro Tools, use your MIDI controller to adjust the parameter you want to record.

MIDI CC data recorded from a ReWire client application
Playing Back MIDI Continuous Controller Data Over ReWire

Once you have recorded MIDI CC data from the ReWire client application to a MIDI track, configure the MIDI track to play the ReWire client application. You can also edit the MIDI CC data in Pro Tools until you achieve the best results.

To play back MIDI CC data over ReWire:

1. From the MIDI track’s MIDI Output selector, select the ReWire client application device you want to control (the same device from which you recorded the MIDI CC data).

2. Start playback in Pro Tools.

3. Switch to the ReWire client application. Notice that the corresponding parameter changes according to the MIDI CC data from Pro Tools.

Quitting ReWire Client Applications

When quitting Pro Tools sessions that integrate ReWire client applications, quit the client application first, then quit Pro Tools.

⚠️ If you quit Pro Tools before quitting ReWire client applications, a warning dialog may appear stating that “one or more ReWire applications did not terminate.” To avoid this, quit all ReWire client applications before quitting Pro Tools.

Tempo and Meter Changes

Pro Tools transmits both Tempo and Meter data to ReWire client applications, allowing ReWire-compatible sequencers to follow any tempo and meter changes in a Pro Tools session.

With the Pro Tools Conductor button selected, Pro Tools always acts as the Tempo master, using the tempo map defined in its Tempo Ruler.

With the Pro Tools Conductor button deselected, the ReWire client acts as the Tempo master. In both cases, playback can be started or stopped in either application.

⚠️ Pro Tools supports tempo values from 30–300 bpm. When slaved to a ReWire client application, Pro Tools playback will be restricted to this range even if the client application’s tempo is outside this range. Additionally, some ReWire client applications (such as Reason) may misinterpret Pro Tools meter changes, resulting in mismatched locate points and other unexpected behavior. To prevent this, avoid using meter changes in Pro Tools when using Reason as a ReWire client.
Looping Playback

Because Pro Tools does not offer separate loop markers as found in other third party applications such as Reason, if you want to loop playback, do one of the following:

**To loop playback in Pro Tools:**

1. In the Pro Tools Timeline, select the time range that you want to loop.

2. Begin playback by pressing the Spacebar or clicking the Play button in the Transport.

**To loop playback within a ReWire client sequencer**

- With playback stopped, specify the loop within the ReWire client application and begin playback.

⚠️ *If you create a playback loop by making a selection in the Pro Tools Timeline, once playback is started, any changes made to loop or playback markers within the ReWire client application will deselect the Pro Tools Timeline selection and remove the loop.*

Automating ReWire Input Switching

ReWire supports automation for switching inputs during playback.

> For information on drawing automation, see the Pro Tools Reference Guide.
SansAmp PSA-1

(Punched up existing tracks or record great guitar sounds with the SansAmp PSA-1. Capture bass or electric guitar free of muddy sound degradation and dial in the widest range of amplifier, harmonic generation, cabinet simulation and equalization tone shaping options available!)

SansAmp PSA-1

How the PSA-1 Works

B. Andrew Barta of Tech 21, Inc. introduced the SansAmp Classic in 1989. A guitar player with both a trained ear and electronics expertise, Andrew and Tech 21 pioneered the market for tube amplifier emulation.

SansAmp’s FET-hybrid circuitry captures the low-order harmonics and sweet overdrive unique to tube amplifiers. And pushed harder, SansAmp also generates cool lo-fi and grainy sound textures that still retain warmth.

SansAmp also features a proprietary speaker simulator which emulates the smooth, even response of a multiple-miked speaker cabinet—free of the harsh peaks, valleys and notches associated with single miking or poor microphone placement.

Finally, SansAmp provides two extremely sweet sounding tone controls (high and low) that sound great on most anything.

Tube sound, speaker simulation, warm equalization and cool lo-fi textures—no wonder thousands of records feature the classic sounds of SansAmp!
**PSA-1 Controls**

Use the eight knobs to dial in your desired tone or effect.

**Pre-Amp** Determines the input sensitivity and pre-amp distortion. Increasing the setting produces an effect similar to putting a clean booster pedal ahead of a tube amp, overdriving the first stage. For cleaner sounds, use settings below the unity-gain point.

**Buzz** Controls low frequency break up and overdrive. Boost the effect by turning clockwise from the center point indicated by the arrows. As you increase towards maximum, the sound becomes (you guessed it) buzzy, with added harmonic content. For increased clarity and definition when using distortion, position the knob at its midpoint or towards minimum.

**Punch** Sets midrange break up and overdrive. Decreasing from the center produces a softer, “Fender”-style break up. Increasing the setting produces a harder, heavier distortion. At maximum, it produces a sound similar to a wah pedal at mid-boost position placed in front of a Marshall amp.

**Crunch** Brings out upper harmonic content and, on guitars, pick attack. For cleaner sounds or smoother high end, decrease as needed.

**Drive** Increases the amount of power amp distortion. Power amp distortion is associated with the “Vintage Marshall” sound—using SansAmp, you can produce the effect even at low levels.

**Low** Provides a tone control specially tuned for maximum musicality when used to EQ low frequencies on instruments. Boost or cut by ±12 dB by turning from the center point indicated by the arrows.

**High** Boosts or cuts high frequencies ±12 dB.

**Level** Boosts or cuts the overall gain to re-establish unity after adding distortion or equalizing the signal.

---

**Tips and Tricks**

**Peace and Unity**

A little known fact: The arrows in the SansAmp controls indicate the unity-gain position.

**Louder and Cleaner**

For best results, don’t set the Pre-Amp level lower than unity gain when the Drive knob is at 9 o’clock or higher. However, if you want a crystal-clear sound and the Drive control is already near minimum, decrease Pre-Amp to further remove distortion.

**Pre-Amp Versus Drive**

To create varying types of overdrive, vary Pre-Amp in relation to Drive. A high Pre-Amp setting emphasizes pre-amp distortion (see “Mark 1” preset), while high Drive settings emphasize power amp distortion (see “Plexi” preset).
chapter 10

Structure Essential

Introduction

Structure Essential is an RTAS (Real Time Audio Suite) virtual instrument plug-in for Pro Tools M-Powered Essential.

Structure Essential brings the world of Structure compatible sample libraries to your Pro Tools M-Powered Essential system and delivers superior performance and reliability thanks to its direct integration with the Pro Tools audio engine. Structure Essential comes with its own 600 MB sample library to get you started.

Structure Essential Features

- 64-voice multitimbral sound engine
- Loads all Structure compatible sample libraries (native Structure, SampleCell, SampleCell II, Kontakt, Kontakt 2, and EXS 24)
- Full compatibility with all Structure versions (Structure, Structure LE, Structure Free), you can easily upgrade and still use your Pro Tools sessions created with Structure Essential. You can also open sessions which originally used Structure or Structure LE with Structure Essential
- Sample playback using disk streaming or RAM
- Support of all common bit depths and sample rates up to 192 kHz
- Easy real-time sound manipulation using Smart Knobs

Getting Started

The following section helps you to explore Structure Essential’s basic concepts with a hands-on approach. You will touch the most important functions, understand the basic concepts and make the first guided steps to get Structure Essential to sound.

Loading Structure Essential


2. Click the track’s Insert selector and choose Structure Essential from the list.

![Inserting Structure Essential on a stereo Instrument track](image)
Making Sound

1 If you have a MIDI keyboard available and prefer to use it, connect it to Structure Essential’s MIDI input, and route it to Structure Essential on MIDI channel 1. If there is no MIDI keyboard available, you can play Structure Essential by clicking the keyboard on screen, or using MIDI input from the Instrument track in Pro Tools.

2 Play some notes on your MIDI keyboard. If all is well so far, you are hearing a sine wave signal from the default Sine Wave Patch at the top of the Patch list.

Loading a QuickStart Patch

To load up a QuickStart patch:

1 Click the double-arrow icon just to the left of the SineWave patch, then choose Structure Essential QuickStart > 01 Six String Guitar to load it and replace the Sine Wave patch.

2 After loading, the multi-purpose display shows a short description of the Patch, and the Parameter panel above displays its Patch parameters.

3 Play some notes and chords. Adjust the Patch volume using the horizontal fader on the Patch module in the Patch list.

Loading a Patch Manually

1 Click the Browser tab in the Parameter panel to display the Browser page.

2 Click your way through the folders to access the Structure Factory Libraries content folder. If you chose the suggested path during installation, it is located here, depending on your OS:

Mac OS X /Applications/Digidesign/Structure/Structure Factory Libraries

Windows Program Files\Digidesign\Structure\Structure Factory Libraries

3 Drag the Patch named 01 Six String Guitar.patch onto the Sine Wave Patch to load it and replace the Sine Wave patch. A red frame around the patch when dragging indicates that you are replacing the existing patch with the new one. Wait until the Loading message in the display beneath the Parameter panel disappears.

4 After loading, the multi-purpose display shows a short description of the Patch, and the Parameter panel above displays its Patch parameters.

5 Play some notes and chords. Adjust the Patch volume using the horizontal fader on the Patch module in the Patch list.
Finding Missing Samples

If a loaded patch does not find its samples because folders have been renamed or moved to another location, you can use the Find Missing Samples file dialog to point Structure Essential to the new location of the samples. Patches which are missing samples are indicated by a red exclamation mark symbol.

To find the missing samples for a patch:
1. In the Patch menu, select Find Missing Samples.
2. In the following dialog, navigate to the new sample location and click OK.

Using Smart Knobs

1. Every Patch has six Smart Knob assignments which are (in the factory content) pre-assigned to useful parameters. You can use them to easily adjust a patch to fit your session. Select the patch to display its Smart Knob assignments in the Keyboard section.
2. Set the Smart Knob for Delay Mix to 30%.
3. Set the Smart Knob for Chorus Mix to 65%.
4. Play some notes. Set the other Smart Knobs at will.

Using Key Switches

Key Switches are special MIDI notes or keys that are assigned to affect control values instead of triggering notes. For example, they can switch between different Smart Knob settings for a Patch or mute certain parts within a patch.

1. Load Patch 03 90s Electronic Kit.patch, and play with it on your keyboard.
2. The different Effects in this specific Patch are not audible initially. Their Smart Knobs are assigned to Key Switches so you can mix them in by just clicking or playing a Key Switch. All available Key Switches appear blue on the screen keyboard. The currently activated Key Switch is green. After activating a Key Switch, a short description is shown in the multi-purpose display. A Key Switch does not trigger samples that are mapped in the corresponding key range.
3. Click the second Key Switch C#0, or play the corresponding key to add dirt to the kit’s sound.
4. Try out the other Key Switches.
5. The synth pad patch has Key Switches too. Check them out!
Structure Essential Parameters

Keyboard Section

The Keyboard section provides 88 keys for playing Structure Essential, six Smart Knobs, and a context sensitive Info display, as well as the Master volume control for the whole plug-in. You can play and control Structure Essential by clicking the keys, using MIDI input from a MIDI keyboard, or using MIDI data in an Instrument or MIDI track in Pro Tools. When Structure Essential receives MIDI data, the keys reflect the MIDI note input.

Smart Knobs

The Smart Knobs are special controls which can be assigned to one or more Structure Essential parameters in the currently selected patch. These parameters can then be remote controlled at the same time by moving the Smart Knob. This comes in handy for easily designing complex sounds or quickly adjusting a patch to suit your session in terms of feel, timbre, enveloping, or any other sensible sound shaping parameter. In Structure Essential’s factory content, each patch has Smart Knobs pre-assigned to important parameters. The Smart Knob can be named in the field above each knob.

Key Switches

Key Switches are special MIDI notes or keys that are assigned to controls and act as a switch. For example, they can switch between different Smart Knob settings for a patch.

Master (Output Volume)

The Master control adjusts the volume of all Structure Essential outputs to Pro Tools. All patches are mixed down to the Main output by default, and then output to the Instrument, Auxiliary Input, or Audio track on which Structure Essential is inserted.
Info Display

The Info display above the Keyboard section is a context-sensitive text display. When you load something into Structure Essential, it displays a progress bar. When loading a commented patch, it displays the Patch comment. When editing controls, it displays parameter name and value.

To display the control’s current value:
- Click the control without moving the mouse.

To edit the patch comment:
1. Select a patch.
2. Double-click into the Info display.
3. Type in your comment.
4. Press Enter.

💡 The Display does not show parameter values of incoming automation, as multiple parameters in different patches could be changing simultaneously. Only values edited using the mouse are shown.

Patch List

In the Patch list on the left side of Structure Essential, you can create, select, mix, MIDI-assign, route, and group patches.

Click a Patch module to select it for editing in the Parameter panel. The handle on the left of the selected patch is lit. When a patch is selected all of its parameters are displayed in the Parameter panel on the right and assorted into sub-pages.
**Patch Module Controls**

Quick Browse menu

Panorama fader

*Quick Browse Menu for Favorite Folders* Gives quick access to the factory content folders and folders that have been added to the favorites. Click the double arrow to bring up the favorite folders menu from which you can directly select Structure Essential Patches. See “Browser Page” on page 72 for more information on how to add a folder to your favorites.

*Mute Button* Mutes the patch.

*Solo Button* Solos the patch.

*Volume Fader* Adjusts the Patch volume.

*Panorama Fader* Adjusts the patch’s position in the stereo panorama.

*MIDI Channel Selector* Selects the channel on which the patch receives MIDI data.

**Patch Menu**

*Load New Patch*

The Load Patch entry brings up a dialog for selecting a patch that will be added below the currently selected patch in the Patch list.

*Add Patch*

The Add Patch submenu lets you add a new patch to the end of the Patch list. Like the Quick Browse Menu, it gives access to your Favorite folders for loading patches.

**Duplicate Patch**

The duplicate Patch entry adds an exact copy of the selected patch below it in the Patch list.

**Remove Patch**

The Remove Patch entry unloads the selected patch removing it from the Patch list.

**Remove All Patches**

The Remove All Patches entry clears the Patch list of all loaded patches. Click OK in the prompted security dialog if you really want to clear the whole Patch list.

**Cut Patch**

The Cut Patch entry copies the selected patch to the clipboard and removes it from the Patch list.

**Copy Patch**

The Copy Patch entry copies the selected patch to the clipboard.

**Paste Patch**

The Paste Patch entry inserts the copied patch on the clipboard at the end of the Patch list.

**Paste Patch Parameter**

The Paste Patch Parameter entry inserts only the parameter settings of the copied patch to the selected patch.

**Automation Channel**

Structure Essential automatically assigns an automation channel to each patch, each of which provides automation for the most important Patch parameters like level, solo, mute, and Smart Knobs. In the Pro Tools plug-in automa-
tion dialog, the automatable parameters for each channel are distinguishable by the corresponding letter. For example, A Level for the Volume fader of the patch assigned to automation channel A. Automation channels are assigned subsequent to the patches in the Patch list by default. The currently selected patch’s assignment is displayed in the Patch menu.

**Find Missing Samples**

If a loaded patch does not find its samples because folders have been renamed or moved to another location, you can use the Find Missing Samples file dialog to point Structure Essential to the new location of the samples. Patches which are missing samples are indicated by a red exclamation mark symbol.

**To find the missing samples for a patch:**

1. Click the Patch menu and select Find Missing Samples from the menu.
2. In the following dialog, navigate to the new sample location and click OK.

**Copy Samples to Session Folder**

If you have loaded patches from removable media like a CD, DVD, or over the network into Structure Essential, a yellow exclamation mark symbol indicates the affected patches. Use the Copy Samples to Session Folder function to transfer the loaded samples to your computer's disk. After transferring the samples, Structure Essential can load the concerned patches without requiring the source CD, DVD, or network folder.

**Selected Patch** copies the samples of the selected patch to disk.

**All Patches** copies the samples of all patches of the Structure Essential instance to disk.

**Session** copies the samples of all patches of all Structure Essential instances in your session to disk.

**Loading Patches**

You can load patches using the Patch menu or browser.

**To load a patch from the menu:**

1. Go to the Patch menu and click Load Patch.
2. In the following file dialog, locate and select a patch.
3. Click OK.

**To load a patch from the browser:**

1. Go to the Browser page.
2. Navigate to the desired folder.
3. Click and drag the patch file into the Patch list.

**Patches can not be saved individually with Structure Essential. The status of the plugin can be saved as a Settings file or with the session only.**
Main Page

After inserting Structure Essential, the Main page is selected by default. Coming from the Browser page, click the Main tab to access the parameters for patches. The Main page provides easy access to all useful parameters like transposition and filter within two sub-pages. If a patch gets selected Structure Essential switches automatically to the Main page.

To access the Edit sub-pages for the selected patch:

- Click the sub-page tabs in the Parameter panel.

A patch’s parameters on Main page

Patch Edit Sub-Pages

Edit 1 Sub-Page

Octave Transposes the incoming MIDI notes for the patch in octave steps.

Semi Transposes the incoming MIDI notes for the patch in semitone steps.

Fine Tune Tunes the patch up and down in cents.

Pitch Bend Up Sets the upward pitch bend range for the patch in semitones.

Pitch Bend Down Sets the downward pitch bend range for the patch in semitones.

Max Polyphony Sets the maximum number of voices available for the patch.
**Key Range** Sets the key range in which the patch plays. You can define the upper and lower borders and a transition.

**FX Send On** Activates the Effect Send for the patch.

**FX Send Level** Adjusts the level sent from the patch to the Effect Send.

---

**Edit 2 Sub-Page**

**Filter Section**

**Filter Type** Selects a filter type.

**Cutoff** Adjusts the filter cutoff frequency.

**Envelope Level** Adjusts how strongly the filter envelope modulates filter cutoff.

**Filter Envelope Section**

**Attack** Sets the time needed for the filter envelope to reach its maximum value.

**Hold** Adjusts the length of the Filter envelope’s Hold time.

**Decay** Adjusts the time for the filter envelope needed to fall from hold level to sustain level.

**Sustain** Adjusts the level of the sustain segment. The envelope’s signal remains on this level as long as the note is held.

**Release** Adjusts the time for the envelope’s release segment to fall to zero when the note is released. Use shorter times for an immediate closing of the filter. Longer times cause the filter cutoff to decay slowly.

---

**Amplifier Section**

**Vel Sens (Velocity Sensitivity)** Adjusts the envelope velocity sensitivity (range in dB between lowest and highest velocity).

**Amp Envelope Section**

**Attack** Softens the attack phase of Instruments by applying an amplitude envelope to the start of each Instrument hit. Move the control to the right to increase the time needed for the attack to rise to full amplitude.

**Hold** Adjusts the length of the Amp envelope’s Hold time at the end of the attack phase.

**Decay** Shortens the played instrument hits by applying an amplitude decay after the hold time.

**Sustain** Adjusts the level of the sustain segment. The envelope’s signal remains at this level as long as the note is held.

**Release** Adjusts the time for the release segment to fall to zero when the note is released. Use shorter times for an immediate stop of the sound. Longer times cause the sound to fade out.
The Browser lets you search and display the local file system. Patches can comfortably be loaded from here using drag and drop. The Browser is not supposed to be a file manager. Modifying operations like copying, moving, or deleting are not available.

**Common operations in the Browser:**
- Drag a patch into the Patch list to load it.
- Drag a patch onto another in the Patch list to replace it at the same position using the previous settings for MIDI input, Individual output, and Automation channel.
- Drag one or more audio files into the Patch list to load; a new patch is created.
**Browser Controls**

- **Patch** Activates the displaying of only patches.
- **Parts** Activates the displaying of only parts.
- **Sample** Activates the displaying of only samples.
- **Show All** Activates the displaying of all file types.
- **Previous Directory** Navigates to the previous folder.
- **Next Directory** Navigates to the next folder.
- **Directory Up** Navigates one folder level up.
- **Show Favorites** Shows your Favorite folders.
- **Add to Favorites** Adds the selected folder to your Favorite folders (accessible through the up and down arrows in the patch module).
- **New Folder** Creates a new folder.
- **Delete** Deletes the selected file or folder.
- **Folder History** Shows the 20 last selected folders.
chapter 11
Other AudioSuite Plug-ins
(AudioSuite Only)

This chapter describes the available AudioSuite plug-ins.

The AudioSuite plug-ins provide most of the same parameters as their RTAS version. For more information about Multi-Tap and Ping-Pong Delay, see Chapter 7, “Mod Delay II.”

Reverse
The Reverse plug-in replaces the audio with a reversed version of the selection. This is useful for creating reverse envelope effects for foley, special effects, or musical effects (for example, the reverse piano attack at the end of the Beatles' song A Day in the Life).

Reverse plug-in

To reverse an audio region (or selection):

1. Select the region you want to reverse.
2. Choose AudioSuite > Other > Reverse.
3. Ensure that Use In Playlist is enabled.
4. Click Process.
Numerics
7 Band, 2–4 Band, or 1 Band (EQ III) 33

A
Algorithm control 14
amp simulation 61
AudioSuite plug-ins 2

B
Browser (Structure Free) 72
buzz 62

C
cabinet simulation 61
Chorus 7
Church algorithm 14
Click plug-in 5
  Accented control 5
  Unaccented control 5
Clip indicator
  D-Verb 13
crunch 62

D
Decay control 14
Delay plug-in 49
Diffusion control 14
distortion 62
DSP
  and EQ III 44
D-Verb 13
Dynamics II plug-ins 17

E
effects
  Chorus 7
  Flanger 8
  Phaser 10
EQ
  EQ III 33
  see also SansAmp
EQ III 33
  DSP management 44
  Frequency Graph Display 35
gain (inverting) 34
Extra Long Delay plug-in 49

F
Flanger 8
Frequency Graph display (EQ III) 35

G
guitar
  amp simulators 61

H
Hall algorithm 14
harmonic generation 61
Hi Frequency Cut control 15
host processing 2

I
Info display 67
Info display (Structure Free) 67
instruments
  Structure Free 63
inverting gain (EQ III) 34
K
Key Switches 65
Key switches 66
Keyboard section (Structure Free) 66

L
lo-fi
textures 61
Long Delay plug-in 49
Low-Pass Filter control 15

M
Medium Delay 49
MIDI Beat Clock 50
MIDI Output selector 56
Mod Delay II plug-ins 49

O
Output Meter 13

P
Patch Edit sub-pages (Structure Free) 70
Patch list (Structure Free) 67
Phaser 10
plug-ins
working with 2
Pre-delay control 15
punch 62

R
Reverse plug-in 75
ReWire 53
automating input switching 59
client applications 53
looping playback 59
meter changes 58
MIDI automation 56
playing back MIDI continuous controller (CC)
data 58, 55
quitting client applications 58
recording MIDI continuous controller (CC) data
56, 57, 55
signal flow for audio and MIDI 54, 53
tempo sync 58
using with Pro Tools 55

RTAS plug-ins 2

S
SansAmp PSA-1 61
Short Delay plug-in 49
sibilants 26
Signal Generator plug-in 51
Size control 14
Slap Delay plug-in 49
Smart knobs (Structure Free) 65, 66
Structure Free 63, 67
Browser 72
features 63
Key Switches 65, 66
loading patches 69
Main page 70
Patch Edit sub-pages 70, 67
Smart knobs 65, 66

T
TDM plug-ins 2
Tempo Sync 50
Mod Delay II 50
tube sounds 61

U
unity 62

W
wah 62
website 3
working with plug-ins 2